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Application Overview

Before we can model, we'll take a quick look 
at the application environment, just so we can 
find the drawing tools and put them to work.

The Vectorworks Working 
Environment

Go to Tools > Workspaces > Spotlight to 
select the Spotlight workspace. Although we’ll 
discuss workspaces in depth later, you should 
know that a workspace is a collection of tools 
and commands assembled to create a 
working environment in order to accomplish  
a focused set of tasks. In our case, those 
tasks will be designing scenery, lighting, and 
sound for the entertainment industries.

Your screen should now look something like 
the illustration below. For clarity of illustration, 
some things (called palettes) have been 
moved around. If you do not have a blank 

document window open, go to File > New  
and select "Create blank document."

On a PC, the palettes should line up on either 
side of the screen. On a Macintosh, palettes 
have to be aligned manually. The right-hand 
side of the Object Information palette (OIP), 
the Resource Browser, the Navigation 
palette, and the Visualization palette will dock 
to the right side of the screen when you click 
the right side of the title bar and drag the 
palette. These palettes can be resized by 
selecting the lower right-hand corner and 
clicking and dragging. When resizing, you  
will be constrained to the screen.

Of course, some of these restrictions will not 
apply if you have multiple monitors, but for 
this text we will assume you are using a 
single screen.
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On a Macintosh, the windows can be 
collapsed by double-clicking the title bar. 
While the arrangement in the illustration is 
clean, most users will find the need to 
reshape and reorganize the palettes as part 
of their workflow. When the palettes on a Mac 
are docked to the right side of the screen, a 
click on the green button in the top left of the 
document window should resize that window 
to fit between the palettes. Resizing is an 
option in the Vectorworks Preferences 
Session tab. Preferences will be fully 
discussed here later.

The illustration above shows how I choose to 
lay out palettes for my workflow. You may find 
a different arrangement more effective. The 
Navigation palette, Resource Browser, OIP, 
and Visualization palette are stacked in that 
order, as full-height as possible, and aligned 
to the right, wide enough for three objects to 
show as thumbnails in the Resource Browser.

As always, descriptions like "wide enough for 
two objects to show as thumbnails in the 

Resource Browser" will be explained as  
we go along.

I use the window-shade function of the 
MacOS to show and reveal the palettes I 
need, as I need them. 

The Screen

On the left side of your screen you should 
see the Basic tool palette and the Tool sets 
palette, which allow you to access additional 
tools for particular jobs. The Attributes palette 
and the Snapping palette are also to the  
left. On the right you should see the 
Navigation palette, OIP, Resource Browser,  
and Visualization palette.

At the top of the active window, you will  
see the View bar and the Tool bar. The 
Message/Data bar is located at the bottom  
of the window.
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Palettes

Basic Tool Set

The Basic Tool set provides ready access  
to a collection of 2D drawing tools, 2D  
and 3D drawing modifiers, and basic 
dimensioning tools.

On the top left of the Basic tool set you will 
find the Selection tool. Place or hover your 
cursor over the arrow-shaped icon, and see 
the hint indicating the functionality of the tool 
and the keyboard shortcut for accessing the 
tool. You can choose the Selection tool by 
clicking on the icon or by pressing the X key 
(unless you are editing text). 

The Selection tool will be used frequently  
to choose objects for modification, move,  
or duplicate by pressing the Alt (Windows)  
or the Option (Macintosh) key and dragging  
any object.

Next to the Selection tool is the Pan tool, 
very useful for navigating around a drawing 
when you have zoomed in on a detail area. 

The Pan tool can be activated in Boomerang 
mode at any time (unless you are editing 
text) by pressing and holding the spacebar.

Tool Sets

Tool sets are collections of tools grouped for 
specific tasks. Note, for example, that there 
is a Dims/Notes tool set in addition to the 
Dimensioning tools provided in the Basic tool 
set. In the Dims/Notes tool set, the Basic 
tools are joined by additional tools for 
dimensioning and annotating drawings.

The tool sets can be viewed in a number of 
different ways. Note that, as seen in the next 
illustration, you can click on the access arrow 
at the bottom of the tool set's palette to 
choose different ways of viewing the tools 
and the tool sets. In the case of the 
illustration, the tools are icons, and the tool 
sets are icons and text. I personally choose  
to view both as icons and text.
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Attributes

The Attributes palette sets various graphic 
attributes of 2D and 3D objects. When an 
object is selected, the line, fill, line style, and 
opacity of an object may be changed. Notice 
the access arrow at the bottom of the palette 
and the choices available. As you will come to 
find, Make All Attributes By Class can often 
save many clicks.

Snapping/Constraints

The Snapping palette sets options for 
drawing with precise alignment. Constraints 
can be temporarily turned off by pressing and 
holding the single quote (‘) key.

Users may set Preferences for the constraints 
and the displayed grid by double-clicking on 
any of the constraint icons. Constraints help 
with precise drawing and provide cues to the 
SmartCursor. If you do not see the grid and 
the XYZ guidelines as illustrated, double-click 
on any tool in the Snapping palette to access 
the palette preferences, select Grid, and 
check the boxes to show the grid and the 
XYZ axis.

SmartCursor
The SmartCursor provides a series of visual 
cues displayed as text at the cursor’s current 
location. It can create snaps to specific points 
relative to other objects.

Smart Points
Smart Points allow the use of existing 
geometry as drawing guides. When Smart 
Points snapping is on, a Smart Point can be 
defined by pausing the cursor over an object 
point and pressing the “T” key. Drawing can 
then be aligned with that point. The alignment 
is visually shown with a dotted red line.
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Working Planes

The Working Planes palette is not opened by 
default. For the purpose of familiarity, go to 
Window > Palettes > Working Plane to 
open the palette. Locate the palette so it is 
accessible but not in the way of drawing.

Simply put, working planes allow you to 
change the base plane on which you are 
drawing. Typically, the base plane is a flat 
horizontal plane. This palette and the 
drop-down menu on the View bar allow you  
to access multiple saved base planes. 
Vectorworks automatically finds the Working 
Plane when you hover over objects.

The Saved Planes function  
is particularly useful if you are creating an 
object with a plane that you frequently return 
to, like a raked stage surface or a set with 
multiple rakes and levels.

You can now close this palette.

Object Information (OIP)

The Object Information palette (OIP) is a 
critical design control point; every object 
selected in Vectorworks can be manipulated 
via the OIP. When you can’t figure out how  
to change something, look here first. The OIP 
has three tabs: Shape, Data, and Render. 
Shape affects size, location, and specific 
parameters associated with different types  
of objects. Data references information (aka 
Records) associated with objects for use in 
worksheets, and Render affects the look  
of 3D objects in presentations.
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Resource Browser

The Resource Browser allows access to 
symbols, textures, and other data within your 
file, and other files that may or may not be 
open. Select the disclosure arrow at the top 
right of the Resource Browser and note the 
Add New Favorite Files option. Although  
we'll come back to it at length later, you 
should know that this allows you to navigate 
to other files and always have access to 
resources you frequently use. There is 
Default Content, not always immediately 
visible here, available from within the 
Vectorworks application. For example, the 
Default Textures can be accessed from the 
OIP and when editing class definitions. 

Navigation

The Navigation palette will be covered 
thoroughly, but for now, notice that this palette 
allows you to quickly access Classes, Design 
Layers, Sheet Layers, Viewports, Saved 
Views, and References. Each of these items 
will be covered and defined. From the 

Navigation palette you can activate, navigate, 
and control visibilities.

Visualization

The Visualization palette will be covered later. 
Note that this palette allows control of Light 
Objects and Camera Objects.

Document Window

View Bar
The View bar allows immediate and constant 
access to a number of important functions. 
View bar functions can be hidden and 
displayed from the drop-down list accessed 
via the Disclosure Arrow on the right of the 
View bar. From the left you will see forward 
and backward arrows; clicking on these will 
take you back and forth between recent 
document views. Skip to the center right, and 
you will see two magnifying glass icons that 
take you to a view of either a selected item  
or to a view of all items in the visible drawing 
(if nothing is selected). Command + 6 on a 
Macintosh and Control + 6 on a PC have  
the same functionality.

In the View bar, a drop-down menu allows 
you to select the working plane of your 
drawing. There are up to three basic options 
available here (excluding any saved planes): 
Layer, Screen, and Automatic.
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When working on different planes, the red, 
blue, and green axes will shift to the active 
working plane.

There is a drop-down menu for your view of 
the drawing. The view defaults to Top/Plan 
(Command + 5), which is the 2D view from 
overhead. In the illustration of the working 
area, the view is set to Right Isometric.

Top is a 3D overhead view, and the others 
should all make logical sense. You may also 
access each of these views from your 
numeric keypad with 5 being Plan, 2 being 
Front, 4 being the left view, 6 being the right 
view, and 8 being the back. The isometric 
views are the four corner numbers.

Drawing in the screen plane with a 2D 
drawing tool from the Basic tool set gives you 
a 2D object that is locked to the screen or the 
front of the drawing space. As you change 
views, the object remains as a flat 2D 
elevation. In the Layer Plane mode, drawing 
2D or 3D objects places the objects on the 
working plane. This is most readily evident 
drawing a rectangle in an isometric view, as 
you can then draw the rectangle in 3D space. 

In fact, you can draw a 2D rectangle, walls, or 
any primitive and then extrude into 3D space 
without switching tools when you select the 
Push/Pull option in the Tool bar. This mode is 
not available in the Top/Plan view.

The Automatic Layer Plane option is active, 
and you can select it when you have a 3D 
object and are drawing other 2D or 3D 
objects adjacent to the original. Hovering the 
2D or 3D Primitive tool over the surface of the 
original 3D object causes the face plane of 
the original object to be highlighted. With the 
Push/Pull tool option selected, you can 
extrude objects in the active working plane.
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On the right of the View bar you can select 
the disclosure arrow and choose the options 
available in the bar. These are choices made 
based on individual workflow. For our purposes, 
please select the options illustrated.

Tool Bar
The Tool bar is just below the View bar and 
displays different options available for each 
tool selected from the Basic tool set or one  
of the task-specific tool sets. 

From within the Tool bar, each tool has a 
variety of settings available on the left of the 
Tool bar. For example, rectangles can be 
drawn diagonally, from the center out, from 
two sides, and rotated. The option to activate 
the Push/Pull capability allows you to 
immediately draw an extrude into 3D. You 
can shift between drawing modes by pressing 
the "u" key. This is particularly useful with the 
Polyline tool, which creates shapes with 
straight lines and/or a variety of different 
types of curves.

Quick Preferences
On the right of the Tool bar you have Quick 
Preferences, which are frequently used 
settings available from the Vectorworks 
Preferences that allow the user to make  
rapid interface changes, as desired. Select 
available options via the Disclosure Arrow  
on the right of the Tool bar.

Message Bar
The Message bar displays precise 
information about the location of the cursor in 
the drawing space. Preferences accessed via 
the Disclosure Arrow in the far right-hand 
corner of the screen can affect this display. 
Additionally, the Message bar displays 
important alerts, back-up information, and 
rendering progress.
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Moving the View

To pan across the drawing at any time (even 
if a tool or command is active), hold down the 
Space bar and drag the cursor. The 
Boomerang mode will return you to the active 
tool as soon as the space bar is released. 
Boomerang mode does not work when you 
are editing text.

You may also directly select the Pan tool  
from the Basic tool set. Scroll bars can be 
activated or deactivated from the 
Vectorworks Preferences.

Zooming
By default, the application's preferences set 
the scroll wheel of the mouse to zoom in and 
out. Similarly, two fingers on a multitouch 
track pad will zoom in and out of a drawing.

From the View bar, click Fit to Objects 
(Command/Control + 6), which adjusts the 
view to fit the selected object to the screen. 
When nothing is selected, the same action 
will fit all objects to the screen.

Command/Control + 1 will zoom in, 
Command/Control + 2 will zoom out, 
Command/Control + 3 returns to the last 
view, and Command/Control + 4 shows the 
full-page view.

OK, now let’s really draw something. 
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government, CNN and CNN International,  
a virtual interview with Benjamin Franklin, 
productions of Romeo and Juliet and  
The Tempest, and the Chase Bank Flagship 
Signage in Times Square. His design 
sketches are held in private collections  
and in the permanent collection of the  
Library of Congress.

Kevin is a longtime Vectorworks user  
and has always used the program as  
a 3D modeler. He has taught, lectured,  
and demonstrated the application on the 
university level and, most recently, at  
the Broadway Lighting Master Classes.

Kevin’s work can be seen at http://klad.com. Kevin and his wife, Kathleen McDonough, blog at 
http://klad.com/blog. Sometimes he blogs about Vectorworks. Blog posts that specifically deal 
with this book can be found in the category VWX Spotlight and Design.

If you have comments or questions, feel free to e-mail Kevin at klad@klad.com.SAMPLE
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ENTERTAINMENT AND LIGHTING DESIGN 
with Vectorworks Spotlight
written with version 2015

This book will explore the use of Vectorworks Spotlight and Renderworks for use in the 
entertainment industries. Although applicable to film, television, concerts, exhibits, and themed 
architecture or interiors, we will explore a project that creates sets, lights, and sound for the stage — the 
root of entertainment design. 

From one step beyond traditional pencil thumbnails, we will explore a process of design development 
and collaboration with other designers and technical staff. 

This text is tutorial-based and will direct the user to learn the software and prepare the design of scenery 
lighting and audio for a Broadway-scale production. 

Completion of each step will put the user well on the way to mastering the software.

ABOUT THE AUTHOR 
Kevin Lee Allen has received multiple awards for his work in scenic and lighting design in theatre, film, 
television, museums, exhibits, and corporate environments. Notable projects include work for MSNBC 
News, the United States government, CNN and CNN International, a virtual interview with Benjamin 
Franklin, productions of Romeo and Juliet and The Tempest, and the Chase Bank Flagship Signage in 
Times Square. He is especially fond of designing new musicals. His design sketches are held in private 
collections and in the permanent collection of the Library of Congress. Kevin is a longtime Vectorworks 
user and has taught, lectured, and demonstrated the software on the university level and at the Broadway 
Lighting Master Classes.
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